This is a context-sensitive Help file that is called from an application.
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Ability Draw ™

Start the Draw application. If Draw is already open, switch to it.



Ability Launcher S
Start the Launcher. If Launcher is already open, switch to it.

Launcher allows you to open any Ability file and start, or switch to, any other Ability application.



Ability Spreadsheet [

Start the Spreadsheet application. If Spreadsheet is already open, switch to it.



Ability Write i

Start the Write application. If Write is already open, switch to it.



Delete Record button E‘

Delete the current record.
You will be warned that deleting the record will permanently remove it from the database - you cannot undo this

operation.



Columns button

Add or remove columns (temporarily) from view.



Filter button
Define a new filter for the current record source.

A filter allows you to view only specified records, for example, all red wines from a general list of wines.
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Sort Order button

Define a new sort order for the records.



View Table Grid button &

Switch to a table grid view of the data where records are displayed in rows and fields in columns,



View Form button

Switch to a form view of the data where each record is displayed in a new screen and fields are displayed down the
page.



View Report button R

Switch to a report view of the data, ready for printing. Summary totals will be added automatically.

It is easier to hide the columns you don't want included in the report before viewing the report (hint: select the
columns, right-click and select the Hide Columns command).



Design Mode button ke

Switch into design mode for a form or report. Design mode allows you to rearrange the form or report layout, and
add or delete elements.



Browse Mode button

Switch to browse mode so you can view and edit the data in the form.



Add Record button +

Add a record. Type the new record details in the blank record displayed.
Use the Esc key to abdandon the new record.

Use the Add button a second time (or any browse button) to save permanantly.



Delete Record button E‘

Delete the current record.
You will be warned that deleting the record will permanently remove it from the database - you cannot undo this

operation.
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Spell Check button v

Start the spell checker.
If there is no text selected, the entire document will be checked. If there is a selection, only the text within the
selection will be checked.



Application Background

This has no functionality.



Table

This a table view of your data. Every row is a record and every column is a field.



Query
This a query view of your data. Every row is a record and every column is a field.
The actual data comprising a query will also be contained in a table.

Queries only show the rows and columns according to the query definition (see the Query command from the
Format menu.)



Relation
A relation draws together two or more tables in a logical join.

Providing the relation is formed by joining a primary key from one table to an indexed field from another, you can
edit the data. Otherwise, the data is read-only.



Form Browse Mode

Each screen shows one record of editable data at a time.



Report Design Mode
The report is broken into "bands".

Report Header - prints at the start of the report.

Page Header - prints at the top of every page.

Detail - prints once for each record.

Page Footer - prints at the bottom of every page.

Report Footer - prints on the last page of the report and includes summary totals.

In addition, if the data is sorted into groups, a band will print at the start and end of every change in the group
value.



Database Manager

This displays all the database "objects" in a tree structure, including all the tables, relations, queries, forms and
reports.

Use Database Manager to add, open and delete these database objects.

Click on [+] to open a branch and [-] to close it again.



Zoom

Select a zoom factor between 25% and 200% to magnify or reduce the current view.



Column View list

Select a column view from the named column view list. Select Colun View - All to view all fields.

Use the Columns button to define a new column view.



Sort Order List

Select a sort order from the named sort orders list. Select Sort Order - None to clear any sort order.

A
Use the Sort button 2+ to define a new sort order.



Filter List

Select a filter from the named filters list. Select Filter - None to clear a filter.

AT
Use the Filters button to define a new filter.
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Align Left button 5

Aligns the left edges of all selected objects to the left edge of the left-most selected object.
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Align Right button **

Aligns the right edges of all selected objects to the right edge of the right-most selected object.
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Align Top button '**

Aligns the top edges of all selected objects to the top edge of the top-most selected object.
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Align Bottom button

Aligns the bottom edges of all selected objects to the bottom edge of the bottom-most selected object.



F

Aligns horizontally the center points of all selected objects with the center point between outer edges of the left-
most selected object and the right-most selected object.

Center Horiozontal button



Center Vertical button Ed

Aligns vertically the center points of all selected objects around the center point between the outer edges of the
highest selected object and the lowest selected object.



Same Width button =

All the selected objects are adjusted to have the same width.



Same Height button i

All the selected objects are adjusted to have the same height.



Same Height and Width button [

All the selected objects are adjusted to have the same height and width.
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Space Across button

Adjust the space between all the selected objects to be the same horizontally.



Space Down button i

Adjust the space between all the selected objects to be the same vertically.



Zoom In button @l

Step up the magnification of the document.



Select button k

Turns the mouse pointer back into the normal, select mode.



Rectangle button =

Draws a rectangle.



Rounded Rectangle button =

Draws a rectangle with rounded corners.



Ellipse button -

Draws an ellipse.



Line button ™

Draws a single, straight line.



Polyline button 5

Draws two or more connected lines.



Polygon button 5

Draws a many sided shape.



Text Box button A

Draws a text box - allows entry of one or more lines of static text.



Arc button =

Draws an arc, that is a segment of a circle.



View Grid button H

Turns the display of grid points on and off.

If there are too many points to display reasonably on screen at the current magnification, only every other grid
point will be displayed.



Zoom Out button a-

Step down the magnification of the document.



Color Palette

Set the background color (the color of the shape fill) by clicking on a color button.

Set the foreground color (the color of text and lines) by right-clicking on a color button.

L |

[T | . e
[ |

|

Current Select color Custom
Colar Colaor
Settings




Custom Color button

Mix a color to your own specification.



Status Bar

Displays current mouse position in the drawing.



Toolbar Background
Use the Customize command from the Tools menu to add new buttons to the toolbar.

You can reposition collections of buttons (toolbars) using drag-and-drop.









Mail Merge button B

Toggles mail merge mode on and off.

When set to on (depressed), print will step through every record in the attached table. The browse buttons will also
be available to view the data.

When set to off (button is up), print will print only the current record. You can still browse the data but you'll need to
select a field first (that is, double-click on it).
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Confirm button or Enter key

Save the current edit so that the result displays in the field.



b

Cancel button or Esc key

Cancels the current edit and returns field contents back to previous state.



Add Record button +

Add a record. This button is only active in the Database application.



Delete Record button E‘

Delete the current record. This button is only active in the Database application.



First Record button )

Display the first record in the data.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).



Next Record button 4
Display the next record.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).



Last Record button M

Display the last record in the data.

This button is only available if mail merge is turned on (use the Mail Merge button @ ) or a field is selected

(double-click on it).
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Previous Record button

Display the previous record.
This button is only available if mail merge is turned on (use the Mail Merge button ) or a field is selected

(double-click on it).
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Insert Function button

Insert a function into the formula. There are over 200 built-in functions - use the help button in the function dialog
box to get information on each function.



Insert Field i

Insert the current field into the document.



Sort Order button

Define a new sort order for the records.



Filter button
Define a new filter for the current record source.

A filter allows you to view only specified records, for example, all red wines from a general list of wines.



Insert Field i

Inserts the current field into the document.



Filter List

Select a filter from the named filters list. Select Filter - None to clear a filter.

Use the Filters button to define a new filter.



Sort Order List

Select a sort order from the named sort orders list. Select Sort Order - None to clear any sort order.

Use the Sort button to define a new sort order.



Field List

Use the Field List drop-down to select a field and then use the Insert Field button to insert it into the

document.



Current Record Number

Display the current record number. You can type in a number to go to that record directly.

This control is only available if mail merge is turned on (use the Mail Merge button
(double-click on it).

) or a field is selected



Formula Entry Bar

Type the text, number or formula you want for the current cell and press Enter.









File New button O or Ctrl-N

Open a new, blank document.
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File Open button = or Ctrl-O
Open an existing document.

The Open dialog can also be used for finding, copying, moving and deleting files.



File Save button b or Ctrl-S

Save the current document to disk.



File Print button =] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.



Print button =] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.



File Print button =] or Ctrl-P

Prints the current document.
Using the print button will print directly. If you need to specify printing options (which pages to print), select Print
from the File menu or Ctrl-P instead.



Print Preview button & or Alt-F7

Previews the current document.



Cut button & or Ctrl-X

Cuts the current selection to the clipboard ready for pasting (using Ctrl-V ) in another location.



Copy button % or Ctrl-C

Copies the current selection to the clipboard.
You can subsequently paste it using Ctrl-V any number of times, in the current document, or in a document in

another application.



Cut button & or Ctrl-X

Cuts the current selection to the clipboard ready for pasting (using Ctrl-V ) in another location.
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Find button o] or Ctrl-F

Search the current document.
Depending on the context, Find can be used to locate text in a document, numbers or formula in a spreadsheet or
records in a database.



Paste button &, or Ctrl-V

Pastes the contents of the clipboard into the current document.



Repeat Format button c or F4

Applies the last formatting action to the current selection.
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Replace button #h or Ctrl-R

Search for, and replace, within the current document. Use this to replace some or all occurrences of the supplied
text.



Undo button = or Ctrl-Z

Reverses the last edit.



Redo button o or F4

Reverses the last Undo.



First Record button

Display the first record in the data.



M

Last Record button

Display the last record in the data



Next Record button

Display the next record.
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Previous Record button

Display the previous record.
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